DIRECTORATE FOR QUALITY AND STANDARDS IN EDUCATION
Department for Curriculum Management and eLearning

Educational Assessment Unit

Annual Examinations for Secondary Schools 2012

FORM 2 Information So@munication Technology TIME: 30min

Name: Class:

Section A: Multiple Choice QuestionsChoose the most suitable answer and write your @nsw
the table provided at the end of this section.

1. Which of the following is referred to as 6. A common way of infecting your
“read and write” memory? computer with a virus is by:
A. RAM A. connecting it to old computers.
B. CPU B. opening email attachments.
C. ROM C. saving a file in a pen-drive.
2. The processing speed of the CPU is 7. What is the best way of protecting your
measured in: computer from getting a virus?
A. Gigabytes (GB) A. Install a new hard drive.
B. Gigahertz (GHz) B. Install anti-virus software.
C. Megabytes (MB) C. Remove dust from the computer to
keep it clean.
3. By increasing one of the following, the 8. An employee using an extranet can:
computer performs faster. Which one? A. access the private network of his/her
A. ROM company from home.
B. RAM B. access all private networks.
C. Weight of the PC C. access any site on the World Wide
Web.
4. Which one of the following is most likely 9. Anintranet is:
to contain a virus? A. A website which can be accessed by
A. RAM everyone.
B. CPU B. A smaller version of the internet that
C. Pendrive can be accessed by authorised
members of an organisation.
C. A very fast search engine.
5. Which one of the following is an example 10. A phishing mail attempts to:
of a personal computer? A. hack your computer.
A. Smartphone B. transmit a virus.
B. PDA C. acquire usernames and passwords.
C. Tablet
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11.To uninstall an application you need to:
A. select the program and hit the Delete
button.
B. select the program icon and drag it to
the Recycle Bin.
C. open the Control Panel.

12.Deleted files from a pen drive:
A. can be found in the Recycle Bin.
B. are moved to My Documents.
C. are permanently deleted.

13.You CANNOT sort your files by:
A. Date.
B. Frequently used.
C. Type.

14.Which of the following units of file size
measurement is the smallest?

A. GB
B. MB
C. KB

15.Folders are needed to:

you choose to add a border
paragraph when using a word
A.
B.
C.

17.To move a picture from one document to
another you have to:
A.
B.
C.

File
Format
Insert

Cut and Copy.
Cut and Paste.
Copy and Paste.

18.What is the use of the TAB key?

A. Helps to align text instead of
inserting spaces.

B. Inserts a new paragraph.

C. Helps to type text in uppercase.

19.To search for a word or phrase in a

document:

A. click in View menu and select
Search.

B. click in Edit menu and select
Replace.

C. click in Edit menu and select Find.

20. RSS feed allows users to:

A. create files. A. read new content when it becomes
B. create documents. available on a website.
C. organise files. B. remove viruses from email
attachments.
C. delete unwanted emails
automatically.
Write your answers in the following table:
Question | Answer Question| Answer Question| Answer Question| Answer
1 6 11 16
2 7 12 17
3 8 13 18
4 9 14 19
5 10 15 20
[20 marks]
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Section B: Answer all questions.

1. This question is about the use of ICT in everydalife.

a)

b)

C)

iii. Using the government website to pay tax online.

iv. Sending a message using an online mailing system.

John works in an office using a desktop compitom 8:30 am till 5:00 pm from Mo
to Friday. At home he uses his laptop for browsiciggatting and social networking f
another 2 hours. Listwo suggestions to help John avoid health problematael to
continual use of a computer.

[4 marks]

Internet servicesare making life easier. Write the name of thedfelhg services:

i. Paying online electricity bills using your bank aaat.

ii. Buying tickets from a website using a debit card.

[4 marks]

Maria is studying History using another inefreervice calle@-Learning. She can read
notes and other content that helps her to leatemhet

Write aboutthree features of e-Learningthat makes it so popular with students.

[6 marks]
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d) Veronica is a young mother. She choosewaok from home e

e) Veronica knows that recycling computer composiéstthe best

f)

with a company that sends her documents using eAvér she *:;; |

completes her tasks, Veronica sends them backrtodmepany. F’ﬂ e
In this way she can take care of her baby while gleting her § ¢
work. Y

i. This kind of work practice is called

ii. Write two advantages of this kind of work practice:

iii.  Write two disadvantages of this kind of work preeti

[5 marks]

choice to reduce waste and take care of the enveon

List two things that she can recycle while workimigh her
computer.

[2 marks]

What can Veronica do to save energy and elettiodlls while working with her
computer?

[2 marks]
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2. This question is aboumanaging files

Look at the following picture and answer the quesi

% Tropical

J File Edit “iew Favorites Tools  Help

J G Back - \_’;,I b le‘ | /..-] Search H__ Folders

J fddress |0 C:\Birds! Tropical

E',

Folders X | _Mame - | Size | Type | Date Modified |
(& Desktap o[ SBird show ; File Folder 10/11/2011 17:33
lD My Docurnents | Dcartaons File Folder 10/11/2011 17:34
=] ; My Computer I videos File Folder 10112011 17:32
=] e Local Disk (C:) b IzlJE!iru:I numbers, xls 18KE Microsoft Excel Workshest  10/11/2011 17:37
) assembly .'_‘::LBIazing.I:ump 2,294 KB EBitmap Image 100112011 17:40
=l ) Birds .'_‘::I.Eagle.l:nmp 042 KB Bitmap Image 100112011 17:41
) Prey |24 Falcan.bmp F73KB  Bitmap Image 10/11/2011 17:42
) Scraphook IE_ﬂF‘.Eurru:ulzs.u:h:u: 11 KB Microsoft word Document 10/11/2011 17:35
[= I Tropical
IC5) Bird Show
ui'l Cartoons
I videos | 4 | ﬂ

a) In whichdrive are the above files and folders stored?

b) How many subfolders does the foldeopical contain?

c) What is the structure shown in the picture called?

d) What does the [+] sign indicate?

e) Write down the name ofWO folders that do not contain subfolders.

and

f) Write down the name of treelected folder

g) How many files are stored in this folder?

h) By which criteria are théles sorted?

i) What is thename of thelargest file?

j) Describe how you can sort the filesigmein descendingorder.

k) Describe how you can rename the Fl@con.bmpto Falconer.bmp.

[12 marks]
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3. Marika and Paul are using a computer to pro@ugemject about birds. The pr
includepictures, graphics and short paragraphs teixt. They are using a comput
following programs:

spreadsheet presentation browser word processor

a) Fillin the blanks usinthree of the above listed programs:

I.  They should use the progodypée information about birds.
ii. They should use the progoasinaw a wooden bird’s house.
lii. They should use the internet toview websitesabout birds.

[3 marks]

b) Paul would like tsavea copy of his project files ongen drive. Giveonereason why he
wants to save his files on tpen drive.

[1 mark]

4. Fill in the empty boxes in the picture belowstt the following paragraph formatting:

i. Format the paragraph @ouble line spacing.
ii. Setthe paragraph alignmentlastified.

lii. Set the spacingefore the paragraph t6pt.
iv. Set the spacingfter the paragraph t9pt.

v. Indent the paragraphs hgm from theleft.

£
x

Paragraph

Indents and Spacing l Line and Page Greaks l

zeneral
Alignment; I:IE Cutline level: Body text -
Direction: (" Right-tao-left {* | eft-to-right
Indentation
Before bext: I:El Special: By
Afker ket I:El |{n-:une]| j | il
Spacing
Before: I:E Line spacing: Ak
After: I:El il | il
-

[5 marks]
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Label the following picture with the wordtseader or Footer to show which secti

page Header and which section is the page Footer:

Miodlem hirds are charncterised by feathes.
abeali withnotedh. the Iuying ofbard-
shalld egzs, 2 high metibolic rate,a four-
chamberedhet, wda Hehmrzie

strarg shelton AT 1 g speciers ofbinds ‘q\

on of Hew Zealind was the crdy A
estception, Winzs are evoived foralimbs, 4
et bird spacies candly, with sams. b5
aguprions, fcidig mrtes, penguie, amd

anmiber of diverse endemic sl -
speties, EInds ako harewique digestive as
andresp ity systems that ire highly P
adupted for light, Soms hirds specially

commis mdpamots, s te most i /

e Tigere amimal species; pxomber of

b pecies bame beent ohsermed it coring and i ing too k. atd
‘marty social specise erhibi rubal trmemission ofmowledge arross
Emetims

Ty species urdertekee Iz dirtimee ateual migrsions. and mavey more
‘pATforIL shoTter T ElAr mowemerts. Birds are social: thiey commmicate
1sing miual sigtials and Bronaah calls ad songs. md particpate T socil
bebiriours, including comperatire breeding arel bunting, flock iz, md
mobbing ofpredators . The Tastmajorky Ofbird specis are socially
momogamons. UL FiT ot hiee diriz S1SM A4 TS, SOMANES for
oA, bt ey o 1 . Othier spec .zshmepal)'gmmx('mw
females")or, Toreky, pobrandrons (“marey males"y threeding sytems. Egzs
are usually Jaid i o rwest and incubate db)rtthurems Host birds hane an
sstemded period ofparesal care adr banching.

b) The picture below shows thkieader and Footertoolbar.

Header and Footer

[2 marks]

Insert AutaText =

lﬂﬂﬁ@@ M@%Eqﬁ&p Close

Insert Time

Insert Date Author

Switch Between
Header and Footer

Insert Number

Insert Page Number of Pages

Use the words from the table above to completédaif@ving table:

Tool Button

What do we use it for?

Insert AutaText -

Inserts auto text, such as

©| |
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6. This question is abostide presentations

a)

b)

Help Paul prepare a slide show presentation.

— =

1 2 3

I Paul wants to insert a Title Slide. He should cbicklayout number
ii.  The next slide consists of a title and text. Heusthalick on layout number
lii.  The third slide is going to show a table. He shaiidose layout number
iv.  The fourth slide has a title, a column graph andestext. He picks layout

[4 marks]

Paul draws a bird’s wooden box. Use the follmpcommands to describe what he is doing
to the picture:

Rotate Left 90°, Rotate Right 90°, Flip Horimntal, Flip Vertical, Resize

N
< 2
AR

A
sy
TN T
R0

[5 marks]
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7. This question is about the use of spreadsheets.

Microsoft Excel - chicken.xls

E‘ﬂ File Edit iew Insert Format Tools  Data Window  Help
NESH SR VE % RB-F 9045l -0 M
- aria -0 - B 7 U EEEH PR EH--A [
515 - e
AIBICIDIEIFIG'|I-§
1 |Northern Chicken Coop
2
3 _ 2007 2008 2009 20110 2011
4 |Hill Farm 45 70 o 143
5 |Valley Farm _ BS g0 i _ 136
B |Sunset Farm 70 93 120 166
ki o
8 |Total _ 188 #MAME? 303 i} 445
S |Average b3 g1 101 #OpAO 148
10 Maximum _ b= 1200 a 166
11 |Minimum _ 45 70 _ 0 136
12 i
M 4 b M| Sheetl / SouthernCoop £ Sheetd / 1E}} | LlJ_‘
Ready o
a) Look at the above picture to complete the foihy:
I Write thename of theworkbook:
ii.  Write ameaningful namefor Sheetl:
li.  Write thevalue that should appear oell C10
[3 marks]
b) Look carefully at the picture and complete fiblowing:
I. The formula in cell B8 is
li.  The formulain cell C9is
iii. The formulain cell F10 is
iv. The formulain cell F11 is
[4 marks]
c) There is the erragtNAME? in cell C8. Give a reason for this error.
[2 marks]
d) Underline the best answer.
There is the errgtDIV/0! in cell E9. This can be corrected by:
A. Entering a positive number in one of the cells E&0or E6.
B. Deleting the formula from cell E9.
C. Changing the value in cell E8 to 1.
[1 mark]
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8. This question is about emails.

d)

ﬁ Birds and Feathers Project - Message |

: File Edit  Yew Insert Faormat  Tools  Table  ‘Window  Help
i B | = orade| -3 B |-
i=d%end | ] - |02 8. 24 ¥ B | ¥ | A3 2 options... = | HTML -
Ll From... | paul. xerrifdyle. com |
& To... |w |
[l | matika@skola,com |
Ul e | horace. camilleri@yle, com |
Subject: |Bir|:|s and Feathers Project |
e S| % S | Aal > 10 = é. -'B I U E - :
Hi Martina,
Pleaze send any pictures far the Birds and Feathers project on this email address.
Cheers, t
Faul @
F
Write the subject of this email: [1 mark]

Paul asks Martina to send him pictures on “tmil address”. Which email address
should Martina use? [1 mark]

Paul sends the same email to two other petsesides Martina. Write their email
addresses:

[2 marks]
Explain the difference betwe&t andBcc. How does this affect Martina?

[3 marks]
Explain the difference betweReply andReply to All.

[3 marks]

End of Examination Paper

www, StudentBounty.com
-Homework Help & Pastpapers


http://www.studentbounty.com/
http://www.studentbounty.com

